Digitisation Workflow and Guidelines

Digitisation Processes

This document outlines the workflow and best practice required to implement the digitisation of physical objects as part of the CHARTER project. It details the CHARTER scanning requirements and parameters for the creation of preservation master files and compressed images for viewing. This document has drawn from documents created and made available by University College Dublin, TASI, UKOLN, University of Virginia and The National Archive.

Ahmed Abu-Zayed
University Of Exeter
03/12/2009
Contents

1 Documenting Digitisation Workflow ................................................................. 4
2 Metadata (technical) Capturing ........................................................................... 5
  2.1 Basic Data Capture ......................................................................................... 5
3 Principles ........................................................................................................... 6
4 Digitisation Requirements ................................................................................... 7
  4.1 General .......................................................................................................... 7
  4.2 Bit Depth ........................................................................................................ 7
  4.3 Capture resolution ......................................................................................... 7
  4.4 File Formats ................................................................................................... 7
  4.5 Colour Management ....................................................................................... 7
  4.6 Sizing ............................................................................................................ 8
5 CREATION OF PRESERVATION MASTERS (PM) .................................................. 8
  5.1 Introduction ................................................................................................. 8
  5.2 Compressed version in JPEG (DL) ................................................................. 9
6 IMAGE MANIPULATION ..................................................................................... 9
  6.1 Orientation ................................................................................................... 9
  6.2 Cropping ....................................................................................................... 9
  6.3 Skewing ....................................................................................................... 9
  6.4 Stitching ....................................................................................................... 9
  6.5 Blank Leaves ............................................................................................... 10
  6.6 Scanning Summary ...................................................................................... 10
7 CREATION OF SURROGATES .......................................................................... 10
8 CREATION OF OFF-LINE IMAGE ARCHIVE ..................................................... 10
  8.1 Introduction ............................................................................................... 10
  8.2 Server .......................................................................................................... 10
8.3 DVD-ROM .............................................................................................................................. 11
8.4 LTO ........................................................................................................................................ 11
9 Appendix 1- Sign Off .................................................................................................................. 12
10 Appendix 2 - File Naming Conventions ................................................................................... 13
11 Appendix 3 - Surrogate Files Using Adobe Photoshop CS3: actions to speed up the conversion process. ................................................................................................................................................. 15
12 Appendix 4 – Scan/Capture Setup Settings .............................................................................. 16
13 Appendix 5 – Stitching separate images together, seamlessly creating 1 large image .......... 21
14 APPENDIX 6 – Colour Management Settings for CHARTER in Adobe Photoshop CS3 ........23

© in the collective work – Academic Services, University of Exeter, 2009
1 Documenting Digitisation Workflow

Over 2000 physical objects, such as documents, photographs and artefacts, will be captured and transformed into the digital masters that CHARTER project will subsequently work with. Dealing with many variables and tasks in this process – for example the method of capturing digital images in a collection (scanning or digital photography) and the conversion processes performed to create surrogates – is vital for the results to remain consistent and reliable.

By documenting the workflow of digitisation, a life history can be built-up for each digitised item. This information is an important way of recording decisions, tracking problems and helping to maintain consistency and give users confidence in the quality of the CHARTER’s work.

Workflow documentation will allow us to tell what the current status of digitising an object is, and how it has reached that point. The details about each stage in the digitisation process and its outcome will be documented according to the following sample template:

<table>
<thead>
<tr>
<th>File name</th>
<th>Operative</th>
<th>Date</th>
<th>Method</th>
<th>PM (size in mb)</th>
<th>DL (size in mb)</th>
<th>VU (size in mb)</th>
<th>Metadata</th>
<th>On server</th>
<th>On DVD-ROM</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>BD034564_01</td>
<td>VS</td>
<td>01/03/09</td>
<td>Sca</td>
<td>26.5</td>
<td>3.7</td>
<td>0.32</td>
<td>y</td>
<td>y</td>
<td>CH_BD_001</td>
<td>The BD034564 slide object consists of 5 items.</td>
</tr>
<tr>
<td>BD034564_02</td>
<td>VS</td>
<td>01/03/09</td>
<td>Sca</td>
<td>20.7</td>
<td>2.5</td>
<td>y</td>
<td>y</td>
<td>CH_BD_001</td>
<td></td>
<td></td>
</tr>
<tr>
<td>BD034564_03</td>
<td>VS</td>
<td>01/03/09</td>
<td>Sca</td>
<td>18.5</td>
<td>1.3</td>
<td>y</td>
<td>y</td>
<td>CH_BD_001</td>
<td></td>
<td></td>
</tr>
<tr>
<td>BD034564_04</td>
<td>VS</td>
<td>01/03/09</td>
<td>Sca</td>
<td>18.5</td>
<td>1.3</td>
<td>y</td>
<td>y</td>
<td>CH_BD_001</td>
<td></td>
<td></td>
</tr>
<tr>
<td>BD034564_05</td>
<td>VS</td>
<td>01/03/09</td>
<td>Sca</td>
<td>18.5</td>
<td>1.3</td>
<td>y</td>
<td>y</td>
<td>CH_BD_001</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MS12_2_23</td>
<td>VO</td>
<td>01/03/09</td>
<td>Cam</td>
<td>24.7</td>
<td>3.2</td>
<td>0.37</td>
<td>y</td>
<td>CH_BD_001</td>
<td>The object MS12_2_23 is a single sided letter</td>
<td></td>
</tr>
<tr>
<td>MS14_3_4_01</td>
<td>VO</td>
<td>01/03/09</td>
<td>Cam</td>
<td>15.2</td>
<td>3.2</td>
<td>0.37</td>
<td>y</td>
<td>y</td>
<td>The object MS14_3_4 is consist of 3 papers, double sided letter</td>
<td></td>
</tr>
<tr>
<td>MS14_3_4_01_2</td>
<td>VO</td>
<td>01/03/09</td>
<td>Cam</td>
<td>13.1</td>
<td>2.7</td>
<td>y</td>
<td>y</td>
<td>CH_BD_001</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MS14_3_4_02</td>
<td>VO</td>
<td>01/03/09</td>
<td>Cam</td>
<td>15.4</td>
<td>3.4</td>
<td>y</td>
<td>y</td>
<td>CH_BD_001</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MS14_3_4_02_2</td>
<td>VO</td>
<td>01/03/09</td>
<td>Cam</td>
<td>14.1</td>
<td>2.3</td>
<td>y</td>
<td>y</td>
<td>CH_BD_001</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MS14_3_4_03</td>
<td>VO</td>
<td>01/03/09</td>
<td>Cam</td>
<td>15.6</td>
<td>3.5</td>
<td>y</td>
<td>CH_BD_001</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>b183665249_001</td>
<td>VS</td>
<td>02/03/09</td>
<td>Sca</td>
<td>23.5</td>
<td>2.1</td>
<td>0.48</td>
<td>y</td>
<td>y</td>
<td>CH_BK_002</td>
<td>The object b183665249 is book which has single and double sided pages. The number in red represents the item number in an object. The blue number represents the number of scans for one item.</td>
</tr>
<tr>
<td>b183665249_002</td>
<td>VS</td>
<td>02/03/09</td>
<td>Sca</td>
<td>23.1</td>
<td>2.4</td>
<td>y</td>
<td>y</td>
<td>CH_BK_002</td>
<td></td>
<td></td>
</tr>
<tr>
<td>b183665249_002_2</td>
<td>VS</td>
<td>02/03/09</td>
<td>Sca</td>
<td>21.2</td>
<td>2.1</td>
<td>y</td>
<td>y</td>
<td>CH_BK_002</td>
<td></td>
<td></td>
</tr>
<tr>
<td>b183665249_003</td>
<td>VS</td>
<td>02/03/09</td>
<td>Sca</td>
<td>22.3</td>
<td>2.3</td>
<td>y</td>
<td>y</td>
<td>CH_BK_002</td>
<td></td>
<td></td>
</tr>
<tr>
<td>b183665249_003_2</td>
<td>VS</td>
<td>02/03/09</td>
<td>Sca</td>
<td>21.4</td>
<td>1.9</td>
<td>y</td>
<td>y</td>
<td>CH_BK_002</td>
<td></td>
<td></td>
</tr>
<tr>
<td>b183665249_004</td>
<td>VS</td>
<td>02/03/09</td>
<td>Sca</td>
<td>21.1</td>
<td>1.8</td>
<td>y</td>
<td>CH_BK_002</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

By recording each stage of the digitisation process, the progress of each item can be tracked, providing a detailed breakdown of its history. This is particularly useful for tracking errors and locating similar problems in other items. Each Repository (BD, MS and b) will have an Excel file to record the work flow of the relevant objects.
2 Metadata (technical) Capturing

The actual digitisation of an item is clearly the key point in the workflow and therefore formal capture metadata (metadata about the actual digitisation of the item) is particularly important. Bridge CS3 is used to manage image metadata which is compatible with the IPTC\(^1\) metadata standard (IPTC Core and IPTC Extension). The metadata will be embedded into the TIFF file header.

2.1 Basic Data Capture

It is intended that during scanning/capturing time, basic metadata will be added to the image file using Bridge database (part of Photoshop CS3). Each image file will require the following to be logged and noted:

TECHNICAL METADATA - BRIDGE

Bridge captures a degree of technical metadata already embedded in the image:

- File Name
- Document Type
- Application
- Date Created
- Date File Created
- Date Modified
- File Size
- Dimensions in centimetres
- Resolution (in ppi)
- Bit Depth
- Colour Mode
- Colour Profile

Where a digital camera has been used to produce the image, all or some of the following metadata may also be automatically captured:

- Aperture
- Exposure
- Exposure Mode
- ISO Speed Ratings

\(^1\)International Press Telecommunication Council

http://iptc.cms.apa.at/cms/site/index.html?jsessionid=au3Hs8Cl6W5b?channel=CH0099
3 Principles

The CHARTER project holds the following as the general principles in the digitisation process:

- Best quality possible within constraints of size and projected use.
- Capture image in full size and without compression.
- All images will be stored in a preservation master (PM) format which is full size and uncompressed.

---

• Preservation Master (PM) will be archived off-line and Downloadable copy (DL) will be archived on-line (Dspace).
• Use standard file formats, TIFF for the PM and JPEG for the DL.
• DL version will be created for delivery from PM.
• Documenting the digitisation workflow.

4 Digitisation Requirements

4.1 General
1. The CHARTER mandatory requirement is that each original object shall be reproduced as an uncompressed preservation master (PM) image and a compressed web image for downloading (DL).
2. Thumbnail images will be generated automatically by Dspace.
• In all cases, files will be named in a consistent and semi-human readable format in conformity with the CHARTER file-naming conventions (See APPENDIX II).

4.2 Bit Depth
• All TIFF colour images should be 24 bits per pixel, scanned as colour RGB.
• All TIFF greyscale images should be 8 bits per pixel, scanned as greyscale.

4.3 Capture resolution
• A capture resolution of 450 DPI will be used. This decision is based on calculation of 300 LPI output resolution at 100%.

4.4 File Formats
• Preservation Master (PM): TIFF format, uncompressed, 24 colours or 8 Greyscale bit per pixel.
• Downloading copy (DL): JPEG format, compressed.

4.5 Colour Management
Every device for capturing and reproducing graphics and images (scanner, digital camera, monitor, and printer) has different capabilities for reproducing colour, resulting in colour inconsistencies. In an ICC-based colour-management system, colour profiles are created for each device, so that the colours in an image can be modified throughout the workflow to compensate for the differences in each supported device. The goal is to maintain the visual appearance of the image to the greatest degree possible.

Monitor Calibration is the first and most important step in the Colour Management process. This is achieved using a colorimeter or spectrometer. For the Charter Project we are using an i1Display2. The monitor is the only way of verifying that the images we are creating are accurate representations of the originals. Therefore it is crucial that the monitor is performing at its best and most accurate. This is particularly important as we are capturing images in the wide-gamut Adobe

---

3 http://www.adobe.com/digitalimag/adobergb.html
RGB 1998 profile, while monitors are only capable of displaying the small-gamut s RGB profile. A calibrated monitor will go someway to compensating for this.

Best practice for new monitors is to calibrate once a month. Older monitors may need to be calibrated every week or every few days. The software bundled with the i1Display2 can chart on a graph the difference in your monitor profile each time it is calibrated, giving you a visual representation of how much your monitor ‘drifts’. With a brand new monitor I would not expect to see a great difference between calibrations, but a visual representation can help you decide how often to calibrate.

To calibrate the scanner we use a series of target images supplied by Kodak. These are scanned in to the computer and the originals compared (by eye) with what the monitor displays. If there are differences between the two, the scanner settings can be adjusted to produce the best results, and then saved as a preset for convenience.

To calibrate the camera, we will use a balance card, with 18% grey on one side and pure white on the other. The white side is used to set the white balance in camera. The first shot of the set should include the grey card. When the images are downloaded to the computer, the midtones of the image can be adjusted according to the grey card in Photoshop. This adjustment can then be applied to all the images from that particular set (provided the lighting set up did not change).

With each of these measures we are ensuring colour accuracy between devices and ensuring there is a standard across the workflow. Unfortunately, because of the nature of the Charter output, we must rely on users calibrating their own monitors to get the best results.

4.6 Sizing
- All material is to be scanned at 100%.

5 CREATION OF PRESERVATION MASTERS (PM)

5.1 Introduction
PM of each item will be made in TIFF with a corresponding compressed versions in JPEG (DL) created as part of a batch process.

Colour RGB images are required for all categories of handwritten material. Greyscale images shall be produced for originals that have significant tonal variation and for printed or typewritten matter with black and white or greyscale illustrations. Colour images shall be created for originals that have significant amounts of colour.

Where possible the goal is to have no sharpening or other enhancement. Should it be deemed necessary, sharpen or other enhancement shall be at a level as defined and determined during the start-up and test activity. No sharpening at scanning stage for master, original will be scanned as is.

Image requirements in terms of format, resolution, and compression for the mandatory images are as specified below:

<table>
<thead>
<tr>
<th>Purpose</th>
<th>Description</th>
<th>Format/Compression</th>
<th>Comment</th>
<th>Resolution (dpi)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital Assets</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Collections &amp; Research Support</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Academic Services</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
5.2 Compressed version in JPEG (DL)

The following chart provides a summary of the compressed image specifications:

<table>
<thead>
<tr>
<th>Purpose</th>
<th>Format/Compression</th>
<th>Comment</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Screen-sized (DL)</td>
<td>JPEG is automatically compressed, select High or level 10 compression</td>
<td>Produced from TIFF</td>
<td>1024 x 768 pixels; Or 3000 pixels on the longest side for extra size objects</td>
</tr>
</tbody>
</table>

6 IMAGE MANIPULATION

6.1 Orientation
- All images to be saved in the digital repository in portrait (unless landscape as original).
- Books and bound volume pages to be separated into individual files for each page. DL version will also be available in PDF.

6.2 Cropping
In the case of photographs, sheets or pages, the entire original item will be presented. In no event shall the actual document be cropped. Researchers often wish to be reassured that the entire document has been captured. A "border zone" approximately 1cm or less of the surface behind the scanned document shall be provided whenever possible.

For some combinations of document sizes and scanning equipment, capturing such a margin may not be possible for all four edges of the page but should be attempted.

6.3 Skewing
CHARTER requires that images created from unbound materials shall not be skewed. For bound materials, it is required that images shall not be skewed; however, the tightness of the bindings may result in slightly skewed images. Special care has to be taken by operator to optimise the position of original on scanning bed to avoid this as much as possible.

6.4 Stitching
There is no intention by CHARTER to scan large documents in parts and stitch the resulted images. Documents that are larger than A3 size will be outsourced for scanning in one piece. However, when it’s not feasible to outsource large document, stitching will be implemented.
6.5 Blank Leaves
Interwoven blank leaves in the collection will be scanned. Notes may be recorded in the metadata record indicating blank pages, so as to provide the same look of the original bound document, especially if leaves are physically attached. This also may be noted in the file description field.

6.6 Scanning Summary
1. Position image
2. Preview-scan
3. Crop a margin and check end-points
4. Scan and assign name (Object/item)
5. Update the image record on the Bridge database with the basic metadata (see 5.6 Basic Data Capture)
6. Update the image record on the Excel workflow file.

7 CREATION OF SURROGATES
A compressed web version (DL) will be created. DL will have a similar filename to the archival master with the use of a .jpeg file extension to distinguish the versions. (See CHARTER Object Naming Convention APPENDIX II).

8 CREATION OF OFF-LINE IMAGE ARCHIVE

8.1 Introduction
The Project has selected Gold DVD-R and Linear Tape Open (LTO) for its master archival backups. 2 copies of Gold DVD-R will be created to be used as the primary working copy whilst LTO will be the preservation copy. The multiple copies of data are stored on different media types that are using different base technologies (for example, magnetic and optical). This reduces the overall technology dependence of the stored data.

It has been estimated that the daily output from a scanning/capturing job is approx 30-50 files, depending on the time needed for preparation and creating surrogates. The output of 3-4 working days would fit in 1 DVD-ROM (4.7 gb).

After surrogates have been created, PM will be uploaded to a dedicated storage space on the server.

8.2 Server
A dedicated space on the server for PMs will have the following folder structure:

- Digital Assets
  - Special Collections
    - Archives

---

4 KODAK DVD-R 16x Speed, 100 Years Gold Archive Grade.
5 http://www.nationalarchives.gov.uk/documents/selecting-storage-media.pdf
The PMs are uploaded to these designated folders on the server as well as the recent version of the workflow Excel file. This producer should be done immediately after scanning/capturing.

5 **8.3 DVD-ROM**

PMs from BDC, Archives, and Rare books are backed up on separate DVD-ROMs. And this should be reflected on DVD-ROM name.

File name for DVD-ROM will be that assigned within the workflow Excel file (e.g. CH_BDC001a)

Approximately 150 PMs will be written to each DVD-ROM.

A second copy of each DVD-ROM (e.g. CHARTER_SC001b) is created once the first is burned. Each DVD must have a copy of the workflow Excel file representing only the content of the DVD-ROM.

PMs which have been uploaded to the server and burned on DVD can be deleted from the workstation. The second (‘B’) copy DVD-ROM, to be sent to the Special Collections (Jess Gardner).

8.4 **LTO**

Deep archiving is done using a LTO (Linear Tape Open) Drive. PMs on the server are backed up into LTO. The LTO must also include a copy of the workflow Excel file.

**LTO Backup Procedures:**

1. The Special Collections folder on the server is backed up weekly on LTO.

2. Workflow Excel file must be updated each backup on LTO.

3. Open the CHARTER_dvd_log excel file on the Desktop and fill in the following details: LTO Tape name -- DVD name -- File range -- Backup date – Operator name.
Appendix 1- Sign Off

The ‘Sign-off’ states that the image/basic metadata was created, checked and found to be up to the required quality standard. This requirement is met by the Workflow Excel file utilized by all operators.

1. Object files names.
2. Metadata has been appended using the file application Bridge.
3. Files are sent to Roxio and burned onto two DVDs.
4. Generating jpeg surrogates.
5. Files are backed up on DVDs.
6. Capture and process time are noted.

Once the master files have been backed up on LTO and burned on DVDs, they may be deleted by the digitisation assistant in keeping with storage constraints on the workstations.
10 Appendix 2 - File Naming Conventions

Each archival object reference (RefNo, Item number or bibliographic no.) becomes a unique original identifier and corresponds to a unique Dspace object record which contains file/files based on the original identifier.

When an object consists of more than one item, numbering system two digits will be used to reflect these items. Where there are pages/leaves, the numbering system will be three digits. The numbering system for pages will be the number of leaves including cover, not the given pagination (this will be noted in the other information field). The ‘_2’ for the verso of a leave remains the same.

Examples:
The object reference EUL MS 207/2/12 becomes original identifier MS207_2_12 and refers to a unique object record.

The object reference 23732 becomes original identifier BD023732 and refers to a unique object record.

The object reference b183779801 becomes original identifier b183779801 and refers to a unique object record.

The Reference no. field refers to the reference number of each item. This includes the original_identifier (e.g. MS207_2_12) and a part number in brackets.

Examples:
EUL MS 207/2/2 becomes MS207_2_2

If an object consists of more than one item, the originalref tag is modified to reflect this and to show the relation to other items in the object.

If this item has subsequent parts (i.e. a back to a photo or letter), the originalref tag is modified to reflect this and to show a relationship to the first part.

Example:
MS207_2_12 is a letter and has a back, and so the back is identified as MS207_2_12_2

Manuscripts and pamphlets are considered one object as they are (or were) bound and each page is an item (unless each loose-leaf has been assigned its own object number by the archivist).

Example of a single-sided manuscript:
MS205_3_7_001
MS205_3_7_002
MS205_3_7_003
MS205_3_7_004
MS205_3_7_005
MS205_3_7_006
MS205_3_7_007
MS205_3_7_008
MS205_3_7_009

Example of a single and double-sided manuscript:
MS35_4_6_049
MS35_4_6_050
MS35_4_6_051
MS35_4_6_051_2
MS35_4_6_052
MS35_4_6_052_2
Sequence

The collections are scanned in readable sequence, as far as possible. An example of this would be a newsletter – single piece of paper, folded in two. Scan 1 is for page one, scan 2 has pages two and three, and scan 3 has page four. However, if the paper has been unfolded and does not fold back easily, only 2 scans are done – scan 1 has pages four and one, scan 2 has pages two and three. There is a possibility of cropping the scans and placing the files in sequence at a later date.

Also, scan items as they are found in the collection, even if the pagination does not reflect the order in which they are archived. Flag any noticeable errors in the notes field.

Missing items

Flag all missing items in the notes field but continue with the original reference numbers as if they are present. This will mean gaps in the originalref table on the Excel file but it is in keeping with how the items were archived.
11 Appendix 3 - Surrogate Files Using Adobe Photoshop CS3: actions to speed up the conversion process.

Provided by Victoria Stobo

This process removes some of the repetitive actions associated with creating the downloadable version of a Master image. It also allows for user control of File Naming.

**Creating a 300ppi Jpeg from a primary master file**

- Open the Primary Master File in Photoshop.
- Create New Action – PM to DL.
- Hit Record
- Go to Image > Duplicate. When naming the file remember this will be used each time. So enter the appropriate suffix – in this case _DL.
- Go to Image > Image Size.
- Using Bicubic Sharpener, reduce resolution to 300ppi.
- Hit Stop on the Actions Palette.
- Save your image as per File Naming Conventions.
- Use this action whenever you want to speed up the Conversion process.

**Batching the Conversion Actions**

- All of the Actions above can be batched to apply to changes to a large number of files.
- Open the files you want to change in Photoshop.
- Select File > Automate > Batch.
- In the drop down menu, select the Action you wish to apply to the images.
- Set Source to ‘Open Files’ and Destination to ‘None’.
- Photoshop will apply the actions to the images, which will remain open after the Batch.
- You can now name the new files according to the File Naming Conventions.
Appendix 4 – Scan/Capture Setup Settings

Provided by Victoria Stobo

1. Epson GT 20000:
   a. Plug the Scanner in at the wall and hit the power button. Allow the scanner to warm up for a few moments.
   b. Go to the Start Menu and open the EPSON Scan program. If it won’t open, leave the Scanner to heat up for a little longer.
   c. The Program will open a large settings window. The first drop down box offers a choice of Professional, Home or Office Mode. Choose Professional.
   d. Ignore Document Type and Source and go straight to Auto Exposure Type. Choose Document or Photo depending on the item you are scanning.
   e. I have found that the Document setting is brighter and provides better contrast, whereas the Photo setting is slightly duller but provides more even tonal values.
   f. In the next drop down box, select the Image Type – 24bit Colour for Colour documents and 8 bit greyscale for Black and White. Some documents from the collection may have been printed as halftone, with black or dark brown ink, but should be scanned as colour because of the paper quality, particularly sepia images.
   g. Resolution should be set to 450dpi.
   h. Document Size is automatically calculated and should not be adjusted.
   i. Target Size should be set to Original.
   j. Do not set any Adjustments.
   k. Take the item to be scanned and carefully place it (don’t slide it around!) on the scan bed.
   l. Most scanners ask you to line the document up with the inside corner of the scan bed, but the light emitted by the scanner is at its most focused and bright in the centre of the bed. So place your document in the centre, and use a straight edge to line it up.
   m. Close the lid of the scanner.
   n. At the bottom of the settings window, click Preview.
   o. A dialog box and a new window will appear, counting down as the preview scan is completed.
   p. When the scan is completed, draw a box around the document, leaving a border (roughly a centimetre in real size) using the Marquee Tool.
   q. If you are happy with the Preview Scan, click Scan. If there are differences between the original and the Preview, it is better to make adjustments to a duplicate in Photoshop, rather than optimise the original. So click Scan.
   r. A Save Settings window will open. Select a location for the file, and a name (as per File Naming Conventions.) You can add a Prefix with a three digit suffix.
   s. Image Format should be TIFF.
   t. Click OK.
   u. If you would like to scan another document, replace it on the scan bed, adjust the settings to match, and click Preview.
   v. Continue as before.
For certain kinds of material (Lantern Slides in particular) items can be scanned without the scanner lid, which can be replaced by a light box or a well-positioned studio light with diffuser. This fills the scanner with extra light and makes transparencies look natural. The lid is easily re-attached afterwards.

2. Canon G10

Rather than write a guide to using the camera, I’ll outline the settings used when taking photographs of each item group in the Project.

Important Note on the G10 Wide Angle Lens

The Canon G10 has a wide angle lens, which means it’s not really suitable for close-up shots, which show signs of barrelling. This can be corrected in-camera, but only in Auto mode and cannot be written to RAW. The best way to avoid this side-effect of the wide-angle lens is to make sure there is a gap of at least 55cm between your subject and the lens of the camera. You can zoom in using Optical Zoom without compromising image quality. Make sure Digital Zoom is switched off in the Camera Menu (Digital Zoom reduces image quality).

Three Things to Remember

1. Always White Balance
   - Place a sheet of white paper in front of the camera.
   - Push the Func.Set button on the back of the camera.
   - A Menu will appear.
   - In the top-most section, there are a range of modes for different lighting conditions – cloudy, sunny, indoor etc.
   - Scroll along until ‘Evaluate White Balance’ appears.
   - Push the ‘Disp’ button to set the white balance.
   - Push Func.Set to Exit the menu.
   - You’re now ready to adjust the settings.

2. When photographing under studio lights, always switch overhead lights off.

3. Under different lighting conditions, the settings used for the camera will change. If you are having problems finding the right settings, I would suggest switching the camera to Auto while focusing on the object to be photographed, making a note of the settings the camera switches to, then turn off Auto and select Aperture Priority or Manual Mode. You can use the settings suggested by Auto as a basis for the shot.

Books/Bound Periodicals
• On the mid-grey background, prop the book up, open at the desired page, using foam blocks. Take care when handling very old books.
• Position each light, with diffuser, tilting downwards at 45 degrees, across the table from each other. The light should cross on the book, illuminating it and ridding it of shadows.
• Attach the horizontal mount to the tripod and position it over the book. Clip the camera into the cradle, positioned to take portrait shots of each page.
• Adjust the height of the camera until there is 55 – 60 cm between the lens and the page to be photographed.
• Switch the camera on and use the display screen to make sure the image is straight.
• Place a white sheet of paper in front of the book and use this to set the White Balance.
• At this height and under these light conditions, the following settings should be used – ISO 80, Shutter Speed 1/100, f4.0, exposure compensation +1/3 and macro switched off. You will need to zoom in to fill the screen (remember to leave a 2cm edge).
• When the camera is set, push down on the shutter button halfway until the blue focus box appears.
• Push down completely to take photo.
• Do all the right hand pages first, then move the book carefully to one side, and take all the left hand pages. This way, the camera remains constant and the image size will not change.
• The Converted Files (see below for details) should be saved to separate folders on the computer – one for left, one for right. When all the derivatives are completed, they can be merged together in order.

3D Objects

• Push together both desks to give a stable surface for the EZ Cube.
• Unpack the EZ Cube carefully and place it on the desks. Make sure it is right side up and all the support rods have uncoiled properly, giving it a firm shape.
• Clip up the white back drop, disguising any visible seams.
• Position the lights at the front corners, and extend them upwards, above the level of the EZ Cube. Then point the beams diagonally down through the top corners of the cube, so that they cross in the middle.
• Hold a white sheet of paper, inside the cube, in front of the camera and set the White Balance.
• Place the object to be photographed in the middle of the cube, and adjust the tripod until you have a suitable composition.
• If the object does not sit particularly well, and would be better suspended, use some invisible thread and hooks to hang it inside the EZ Cube.
• When you are happy with the composition, use the following camera settings – I’d suggest upping the ISO slightly because of how bright the studio lights are in the white cube – so ISO 200, f3.5, Shutter Speed 1/40, with no macro. There will not be a need for exposure compensation.
• Because of the variety of 3D objects to be photographed, providing a catch-all guide is not possible. Care must be taken when lighting each piece, and attention must be given when
focusing the camera on a 3D object, to ensure the entire object is in focus rather than only
the side closest to the camera.

- Push the shutter button down halfway until the focus box turns blue, then press to take the
  photo.

5 Lantern Slides

- Switch on the lightbox and place it on the desk. Leave it for ten minutes until the light is at
  full-brightness.
- Place the camera in the horizontal mount, attached to the tripod.
- Measure the distance between the light box and the lens of the camera. Adjust to approx.
  55cm.
- White Balance the camera using the lightbox.
- Place the Slide on the lightbox and zoom in using the camera display as a guide.
- Straighten the slide in the viewfinder.
- Camera Settings will be: ISO80, f4.5, Shutter Speed 1/60, Exposure Compensation + 1/3, no
  macro.
- Push down halfway on shutter to focus, press completely to take the photo.

Flat Prints/Posters

If something under this bracket is being photographed instead of scanned, it’s either oversized or
too delicate for the scanner.

20 Delicate/Fragile

- Carefully place the item on the neutral grey background
- Attach camera to tripod in the horizontal mount.
- Make sure there is a gap of at least 50cm between the item to be photographed and the lens
  of the camera.
- Position the lights on each side with diffusers, ensuring a soft light crosses the item,
  illuminating it and ridding it of shadows.
- Adjust the camera in the mount until the image on the camera display is straight.
- Place a white sheet of paper in front of the subject and use this to set the White Balance.
- Camera Settings – ISO 80, Shutter Speed 1/100, f 3.5, +1/3 exposure compensation.
- Push the button down halfway until the focus box turns blue, then press to take the photo.

35 Oversize

- Place the item on the neutral grey background.
- Decide which corner of the item you are going to start from
- Place a ruler against the horizontal and vertical edges of the item.
- Follow steps 2 – 5 above.
- Move the tripod into a position where you can see the starting corner you have selected, on
  the camera display.
Adjust the image using the camera display until you are happy with zoom and focus.

Use the size of this portion of the image in the display to estimate how many photographs it will take to cover the entire item.

Using the rulers as guides, move the item carefully underneath the camera, photographing as you go, using the camera settings detailed in Step 6 above.

**The Transfer from Camera Raw to TIFF**

There are two ways to transfer images from the Canon G10 to the PC. The first, and quickest way, is using the SD Card inside the Camera.

- Open the battery compartment on the bottom of the camera. The slim blue top-edge of the SD card is visible next to the grey battery.
- Carefully push *down* on the card edge to eject it. It will spring upwards from its slot. Do not attempt to pull it out before it is properly ejected.
- Push the card, metal side down, into the SD reader on the front of the PC.
- A dialog box will open, asking you to choose a program. Close it.
- Select Digital Photo Professional from the Start Menu
- In the menu on the right hand side, select My Computer > Removable Disk > DCIM > 100 Canon.
- The images on the SD Card will appear in the main window. Select the best by clicking and holding down the shift key.
- When you are happy with your selection, click the Batch Process Icon in the top right-hand corner.
- A new window will open displaying Batch Settings.
- Pick a folder to save to. Choose one on the computer rather than the network to speed up the process.
- In File Format select Exif 8 bit TIFF.
- Adjust output resolution to 450dpi.
- Select New File Name and enter the agreed prefix as per File Naming Conventions.
- Select Execute.
- The TIFFs will be sent to the selected folder.
- The conversion process can now begin.
13 Appendix 5 – Stitching separate images together, seamlessly creating 1 large image

Provided by Victoria Stobo

The most important thing to remember which stitching images together is to rename your layers. This enables you to edit the alpha channel, essential for blending images together.

- Open all the images you want to stitch together in Photoshop. Go to Window > Arrange > Tile Horizontally.
- Find the image that will be at the centre of your final image. Double Click the name of the layer in the Layer Palette and rename it.
- Because this is going to be your central image, you need to expand the canvas to fit all the other images in. Count the number of images all together (6 for example).
- Go to Image > Canvas Size
- Using the example of 6 images, increase the horizontal or vertical axis (depending on the layout of your image) by 600%. Increase the other axis by a smaller amount (150%) to give yourself some space.
- If your image is not on the long horizontal or vertical, is more of a patchwork, workout how many images will be on each axis and adjust them accordingly. (A canvas with three images on each axis will need to be increased by 350% on each side).
- Select the image adjacent to the central image. Use the Move Tool (V) to copy it into the new canvas. Rename the layer.
- Set the layer opacity to 50%. Ensure you have the new image selected and not the central image.
- Move the new image over the central, until you find a sharp, clear point near the edge of where the images meet. (You will need to zoom in and out to find this). Do not worry if the rest of the image is unmatched.
- By moving and positioning the new image, we should be able to tell if the scale of the images is different, if they are slightly out of sync in rotation.
- Hit Ctrl + T to transform the current layer. Try increasing the scale of the new image, or rotating it slightly to see the differences between the images. The more stable the camera and subject, the less need there will be for this sort of adjustment.
- When you are happy, hit enter to exit Transform and Apply the Transformation.
- Using the Polyagonal Lasso, select the area where the two images will join, i.e., select the area of the new image that you want to keep.
- Press the ‘Add Layer Mask’ button on the Layers Palette. This creates a Mask that reveals only the part of the selection you want to keep.
- Put Layer Opacity back to 100%.
- Examine the area where the two images join. It is impossible to create a perfect match, and there will be a certain amount of visible overlapping/distortion.
- To minimise this, select the Brush Tool, set the diameter to 50px and Hardness to 0%. Ensure Opacity and Flow are set to 100%.
- Click on the Layer Mask’s Thumbnail in the Layers Palette. (Ctrl + \)
- Press ‘D’ to select White as the foreground colour and Black as the background colour. Pressing ‘X’ swaps those colours round.
• Painting with White reveals pixels on the mask, and painting with Black hides them, so paint up and down the edge where the images join, hiding and revealing pixels, until the join between the images cannot be seen.

• Toggling the Masks’ visibility will reveal any inconsistencies.

• Repeat these steps for all the other images until you have one seamless image.
14 APPENDIX 6 – Colour Management Settings for CHARTER in Adobe Photoshop CS3

Provided by Victoria Stobo

- Open Photoshop
- Go to Edit > Colour Settings
- A large dialog box appears. Make sure you click on ‘More Options’ to see a full list of settings.

10 Under ‘Working Spaces’
- RGB should be set to Adobe RGB 1998
- CMYK can be set to anything – we will not be working with CMYK and preferences for this will be switched off in the next section.
- Gray and Spot should be set to Dot Gain 20% - these are printing preferences and do not need to be set.

Under ‘Colour Management Policies’
- RGB should be set to ‘Convert to Working RGB’.
- CMYK and Grey should be set to ‘Off.’
- All the tick boxes below these options should be ticked – it is important to be alerted to profile discrepancies.

Under ‘Conversion Options’
- Engine should be set to Adobe (ACE), which is an excellent conversion engine, you will never need to change this.

30 Intent: this is possibly the most difficult aspect of Profile Conversion to judge.
- Saturation and Absolute Colorimetric can be discounted as they are best-suited to logos and commercial graphics, not high quality, detailed photographic images.

This leaves a choice of Perceptual and Relative Colorimetric.

Perceptual requests a visually pleasing rendering, preserving the visual relationships between source colours. Often used to render wide gamut source images, where preserving the relationship of colours inside and outside the destination gamut is more important than exactly matching the colours inside the destination gamut.

Relative Colorimetric attempts to match the media – relative LAB coordinates of the destination colours to the media – relative Lab coordinates of the source colours. The source white point is mapped to the destination white point. Recommended for most colour conversions, especially when most source colours are already inside the destination gamut.

Under these conditions, I believe Relative Colorimetric is best suited to our needs.

45 Advanced Controls are for use with very large Gamut images which we do not support as part of the CHARTER Project, so these settings can be left alone.
These settings can now be saved for convenience from the Options on the right. You should take care to make sure these are the settings in use each time you open Photoshop. Give the settings a memorable and relevant name like ‘CHARTER Default Settings’.